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Introduction 
 

The Irish Hip Fracture Database (IHFD) is a clinically led, web based audit of hip fracture casemix, care 

and outcomes. The National Office of Clinical Audit (NOCA) provides operational support and 

governance for the IHFD. All sixteen eligible hospitals in the Republic of Ireland are now entering data. 

It is supported by the Irish Gerontological Society (IGS) and the Irish Institute of Trauma and 

Orthopaedics (IITOS). The IHFD has been in evolution since 2008 and has been actively collecting data 

since 2012. Data is collected through the Hospital In-Patient Enquiry (HIPE) portal in collaboration with 

the Healthcare Pricing Office (HPO). 

The mission of the IHFD is to optimise surgical, medical, nursing, rehabilitation and secondary 

prevention care for all hip fracture patients.Thus far, the IHFD has published one preliminary report 

and three national reports. In 2017, the IHFD will publish its first national report where it will identify 

individual hospitals. In addition to the main report, a facilities audit is also conducted. In 2016, quarterly 

reports were issued to all 16 hospitals and also sent to the hospital groups. 

Following in the footsteps of the other major hip fracture registries, the IHFD is reflective of the UK 

National Hip Fracture Database which is now the largest clinical audit of its kind in the world with over 

250,000 cases already recorded. The IHFD in Ireland will measure the care of hip fracture patients 

against international best practice standards, benchmark hospitals, networks and overall health systems. 

Through the synergy of clinical standards, audit and feedback, this audit seeks to drive quality 

improvement to achieve the best possible clinical outcomes for hip fracture patients in Ireland.   

This handbook aims to give data coordinators the background to the IHFD audit and the tools and 

support guidelines to be able to gather quality data.  Quality data is required so we have clear 

information on all stages of the patient journey to enable us to identify any areas that need 

improvement.  

Quality data in means quality data out! 
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National Office of Clinical Audit 

 

What is clinical audit? 

The Commission on Patient Safety and Quality Assurance (2008) defined clinical audit as: 

“a clinically led, quality improvement process that seeks to improve patient care and outcomes through 

systematic review of care against explicit criteria and to act to improve care when standards are not met” 

About the National Office of Clinical Audit (NOCA) 

NOCA was established in 2012 to create sustainable clinical audit programmes at national level.  

NOCA enables those who manage and deliver healthcare to improve the quality of care through 

national clinical audit. NOCA is funded by the Health Service Executive Quality Improvement 

Division, governed by an independent voluntary board and operationally supported by the Royal 
College of Surgeons in Ireland.  

NOCA Governance Board 

The NOCA Governance Board, is an independent voluntary board which has been convened to 

guide the clinical decision making and strategic direction of NOCA. The NOCA Board has the 

authority to issue directions to NOCA Management with regard to the various clinical audit streams. 

The board will ensure that NOCA administrative processes comply with all legal and statutory 

requirements. It will ensure that NOCA adheres to the highest standards of corporate and social 

responsibility. Its ultimate responsibility will be to agree and sign off on all published annual reports of 
national clinical audits managed under NOCA. 

Audits governed by NOCA 

The current national audits governed by NOCA are as follows: 

 

Audit  Clinical Lead/s 

Major Trauma Audit (MTA)  Dr Conor Deasy 

Irish National Orthopaedic Register (INOR)  

Mr David Moore,   Mr Paddy Kenny, Mr 

James Cashman 

National Intensive Care Audit (ICU Audit)  Dr Rory Dwyer 

Irish Hip Fracture Database (IHFD)  Dr Conor Hurson, Dr Emer Ahern 

National Audit of Hospital Mortality Dr Brian Creedon 

National Perinatal Epidemiology Centre (NPEC)  Prof Richard Greene 
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Data Coordinators  

 

The Data Protection Acts 1988 & 2003 provide the legislative basis for the approach of the Office of 

the Data Protection Commissioner with regard to personal data in the health service, including clinical 

audit.  The key issue is respect for the patient’s reasonable expectation that their health information 

will be kept confidential (Data Protection Commissioner 2007).  To ensure confidentiality to service 

users and to enable access to third parties, all IHFD data available to NOCA and published in national 

reports will be anonymised. 

Local reports that are being used for presentation purposes must not to contain personal patient 

information or Medical Record Numbers (MRN).  Reports that are used as working documents 

between yourself and your Clinical Lead may contain MRN numbers but in reports used for any other 

purposes they must be removed. (see Data Management Page 4 for further measures to protect data) 

In general, audit does not require informed consent (HSE 2013). 

It is good practice to let patients know that their personal data may be used for the hospital’s IHFD 

audit for quality and service improvement purposes and the importance of this audit function within the 

hospital.  There is no requirement for explicit consent provided the patient has access to information 

outlining the possibility that their personal data may be disclosed for local clinical audit. Patient 

Information Leaflets are available in participating hospitals and should be displayed in all areas where 

patients or their families can access them. 

Data Management 

 

Data is only accessible by appropriately authorised staff on a need to know basis.  At hospital level, this 

should include the IHFD Data Coordinator, Hospital Clinical Lead and members of the Clinical 

Governance Committee. 

 Data is checked to ensure confidentiality and accuracy. 

 Data Performa Sheets (if necessary) should only be kept for the length of time they are 

absolutely required (for the purposes of the audit).  Once they are no longer required, they 

should be destroyed immediately.  

 Use appropriate facilities for disposal of confidential waste e.g. shredding or confidential bins 

provided in your hospital. 

 Ensure passwords to the HIPE and IHFD Portal are kept secure at all times and change 

passwords as prompted. Do not share passwords. 

 Ensure that reports are not left visible to unauthorised personnel. 

 If leaving desk unattended press Ctrl + Alt + Del, select lock computer to password protect 

your machine while it is unattended. 

 Retain all paperwork associated with IHFD reports in a locked filing cabinet. 



 

 

      

NOCA - IHFD HB Version 4.0 June 2017   

 

Page | 5 

 All devices used to store data are encrypted (for example laptops and USB devices). 

 Report directly to local hospital management, IHFD clinical leads and NOCA if there has been 

any breach of security. 

 All reports should be anonymised (including removal of MRN numbers) before being made 

available for review and consideration. 

 

Data Quality 

 

IHFD relies on capturing all eligible patients in the IHFD Portal.  Data is considered to be of good 

quality when the correct reliable data is available in a timely manner.  Data quality is described through 

the following dimensions: accuracy, validity, reliability, timeliness and, relevance, legibility and 

completeness (HIQA 2013). 

 Accurate data refers to how closely the data correctly captures what it was designed to 

capture – Refer to Appendix 1 Dataset Dictionary for explanation of answers required for each 

field. 

 

 Complete data has all those items required to measure the intended activity or event – Ensure 

all fields are entered, no blanks – refer to Dataset Dictionary for options if no information 

available for a certain field. 

 

 Legible data is data that the intended users will find easy to read and understand – Ensure all 

handwritten entries in Dataset Performa sheets or Clinical Pathway are clearly legible to others 

  

 Relevant data meets the needs of the information users – Refer to Appendix 1 Dataset 

Dictionary for explanation of answers required for each field. 

 

 Reliable data is collected consistently over time and reflects the true facts – do not complete 

the file until patient has been discharged - Referral to the IHFD Data dictionary will ensure 

accurate interpretation of the questions all of the time.     

 

 Timely data is collected within a reasonable agreed time period after the activity that it 

measures and is available when it is required and as often as it is required. 

 

 Valid data is collected in accordance with any rules or definitions applicable for that type of 

information. These rules check for correctness and meaningfulness before the data is used - 

For example, question 7 requires a positive answer only if the Abbreviated Mental Test was 

carried out.  If another cognitive assessment test was carried out, this would warrant a 

negative answer.  
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HIPE Portal / Hip Fracture Reports (June 2017) 

 

There are seven reports available to hip fracture users of the HIPE Portal. To view the list of reports: 

Click the “Reports” button in the top right of the main data entry screen. 

 

 

 

1. Pre-Discharge Report 

 

This report generates a list of episodes awaiting merger to a discharged HIPE episode, where 

additional hip fracture data has been entered by a hip fracture user. This report can be 

exported to Excel for further analysis (click “Excel” button) 

 

2. Discharged Report 

 

This report generates a list of discharged HIPE episodes, where additional hip fracture data 

has been entered by a hip fracture user. 

 

 

This report can be exported to Excel for further analysis (click “Excel” button) 

It may be useful to create data filters in Excel (click “Data”, then “Filter”) 
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3. HIPE / Hip Fracture Activity Report 

 

This report generates a list of discharged HIPE episodes with a diagnosis of hip fracture 

(principal or secondary) where no additional hip fracture data has been entered by a hip 

fracture user.  

For this particular report, there are a number of options: 

 Select “Standard Report” or “Chart Numbers Only” 

 Select “Exclude Under 60 Years” or “Include All” 

 Select “Discharge Date Range” or “Admission Date Range” 

 

 

 

 

 

Below is a sample report: 
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4. Blue Book Standards 

 

This report generates totals for the six Blue Book Standards: 

 BB1. Admission to orthopaedic ward within 4 hours 

o Age 60+ 

 BB2. Surgery within 48 hours and during working hours 

o Age 60+  

o Surgery Mon-Fri 08:00-17:59 

 BB3. Patients developing pressure ulcers 

o Age 60+ 

o Excludes patients who died 

 BB4. Pre-operative assessment by an orthogeriatrician 

o Age 60+ 

 BB5. Discharged on bone protection medication 

o Age 60+ 

o Excludes patients who died 

 BB6. Received a falls assessment prior to discharge 

o Age 60+ 

o Excludes patients who died 

 

For this particular report, there are a number of options: 

 Select Surgery “Monday-Friday 8-6” or “Monday-Sunday 8-6” 

 Select “Discharge Date Range” or “Admission Date Range” 
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Below is a sample report: 
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5. Hip Fracture Totals 

 

This report generates a list of totals for hip fracture data entered by a hip fracture user. The 

user has the option to exclude patients under 60 years. Below is a (partial) sample report: 
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The totals report now also contains the option to generate a bar chart for each section of the report 

by clicking on any of the underlined headers as shown below: 
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6. Completeness Report 

 

This report generates a percentage of data entered for each hip fracture question, over a 

specified date range. Below is a (partial) sample report: 
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7. Mobile Reporting 

 

It may be useful for clinicians in the hospital to view hip fracture reports, without the need 

for access to the data entry module. Clicking on “Mobile Reporting” opens a new web page 

which requires a four-digit pin number.  

Having selected a discharge year, the user can select from a number of “aggregated” reports. 

Please note this web page will only work on (mobile) devices or desktop computers with 

access to the hospital network. The web page is not available externally to the hospital 

network. 
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Presentation of data  

Using Excel to Create a Chart  

 

The instructions in this section apply to Office 2007 and 2010. The layout of the chart icons on your 

toolbar is slightly different depending on which version you are using, but the steps outlined below 

are the same for both versions. 

 

Excel 2007 Toolbar 

 

Excel 2010 Toolbar 

 

 

Note: Instructions for other versions of excel are available on request.  

Dataset Examples 

In order to guide you creating charts, two sample data sets have been created for demonstration 

purposes:  

Dataset 1 - is used to demonstrate Line Charts and Bar Charts. 

Dataset 2 - is used to demonstrate Pie Charts. 

Month Male Female 

Jan 62 63 

Feb 66 87 

Mar 51 91 

Apr 74 54 

May 83 60 

Jun 69 57 

Dataset 1 – Patient with fractures - Gender/Month  

Walking Ability Pre-fracture Post-fracture 

Independent 53 65 

One Aid 21 19 

Two Aids 16 11 

Wheelchair 7 4 

Not 

Documented 3 1 

Dataset 1 – Walking Ability of Patients, pre and post fractures 
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The datasets have been provided so that you can practice the exercises and step through the 

instructions after the training day.  

 

Line Chart (examples based on Dataset 1) 
 

To create a line chart, execute the following steps. 

1. Select the range A1:C7 

2. On the Insert tab, in the Charts group, choose Line, and select Line with Markers. 

 

Result: 
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Change Chart Type  

You can easily change to a different type of chart at any time. 

1. Select the chart. 

2. On the Insert tab, in the Charts group, choose Column, and select Clustered Column. 

 

Result:  
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Switch Row/Column 

 

If you want gender, displayed on the vertical axis, and month to be displayed on the horizontal axis 

instead, execute the following steps. 

1. Select the chart. The Chart Tools contextual tab activates. 

2. On the Design tab, click Switch Row/Column. 

 

Result:  
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Chart Title 

 

To add a chart title, execute the following steps. 

1. Select the chart. The Chart Tools contextual tab activates. 

2. On the Layout tab, click Chart Title, Above Chart. 

 

3. Enter a title. For example, Number of Hip Fractures by Gender per Month. 

Result:  
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Legend Position 

 

By default, the legend appears to the right of the chart. To move the legend to the bottom of the 

chart, execute the following steps. 

1. Select the chart. The Chart Tools contextual tab activates. 

2. On the Layout tab, click Legend, Show Legend at Bottom. 

 

Result: 
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Data Labels  

 

You can use data labels to focus your readers' attention on a single data series or data point. 

1. Select the chart. The Chart Tools contextual tab activates. 

2. Click a green bar to select the “Mar” data series. Click again on a green bar to select a single data 

point. 

3. On the Layout tab, click Data Labels, Outside End. 

 

Result:  
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Pie Chart (examples based on Dataset 2) 

Pie charts are used to display the contribution of each value (slice) to a total (pie). Pie charts always 

use one data series. 

To create a pie chart of the patient’s Pre-fracture walking ability data series, execute the following 

steps. 

1. Select the range A1:B6. 

2. On the Insert tab, in the Charts group, choose Pie, and select Pie. 

 

Result:  
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3. Click on the pie to select the whole pie. You can click on a slice to drag it away from the centre. 

Result: 

 

 

Remember to set Data Labels 

 

You can use data labels to focus your readers' attention on a single data series or data point. 

1. Select the chart. The Chart Tools contextual tab activates. 

2. On the Layout tab, click Data Labels, Outside End. 
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Result: 

 

 

Remember to Check Chart Title 

To add or amend a chart title, execute the following steps. 

1. Select the chart. The Chart Tools contextual tab activates. 

2. On the Layout tab, select Chart Title, Above Chart. 
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3. Enter a new title. For example, Walking Ability Pre-Fracture. 

Result: 

 

 

To copy/bring existing charts from Excel into MS PowerPoint: 

 

For presentations, you can copy/bring the excel charts that you have created into PowerPoint.  

1. Open PowerPoint and create a new slide.  

2. For charts, change the layout of the slide to Title and Content 
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3. Click on the area box – “Click to add text” so that it is the active. 

 

4. Open Excel or Go to Excel if already open (leaving PowerPoint open in the background) and find 

the chart you want to add to the presentation. 

5. Click on the chart so that it in highlighted and either select the copy icon or press Ctrl +C 

to copy the chart. 

6. Switch back to PowerPoint by selecting Alt+Tab or by selecting the open icon on your taskbar 

 

8. Paste your chart into the active box in PowerPoint by either selecting the Paste icon on the 

toolbar  or by entering Ctrl+V 

 

Result: 
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9. If when you copy the chart into PowerPoint and the style is different, you can right click on 

the Chart and Select Reset to Match Style. 

 

 

 
Result: 

 

Note the size of legend text after you reset Match Style. 

 



 

 

      

NOCA - IHFD HB Version 4.0 June 2017   

 

Page | 27 

Displaying comparative charts 

1. Create a new slide.  

2. For comparative charts, change the layout of the slide to Comparison. 

3. As before, click on the area box – “Click to add text” on the Left side first so that it is the active 

area on the slide. 

4. Open Excel or go to Excel if already open (leaving PowerPoint open in the background) and find 

the chart you want to add to the presentation. 

5. Click on the chart so that it in highlighted and either select the copy icon or press Ctrl +C to 

copy the chart. 

6. Switch back to PowerPoint by selecting Alt+Tab or by selecting the open icon on your taskbar 

 

7. Paste your chart into the active box in PowerPoint by either selecting the Paste icon on the 

toolbar  or by entering Ctrl+V. Your copied chart should now appear on the Left. 

Result: 
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8. As before, click on the area box – “Click to add text” on the Right so that it is the active. 

9. Repeat steps 4 to 7 above. When steps are complete your slide should contain two charts. 

Result: 

 

 

Customizing the Background of your Slides  
 

You can customize the background of individual slides by changing the colour and adding shading, 

texture, or patterns. 

 First select the slide you want to customize. 

 Under the Design tab in the Background group, either click the Background 

Styles button and choose "Format Background..." or click the menu arrow  to bring 

up the Format Background dialog. 

 Select a Fill Style. You can choose from a solid fill, a gradient, or a picture/texture. Play 

around with the settings until you're satisfied. 

o Hint: As you adjust the settings in this menu, PowerPoint will preview the changes on 

your slide. 

To apply the changes only to the current slide, click Close. 

To apply the changes to all your slides, click Apply to All. 

To undo any changes, click Reset Background. 
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Customizing Colour Schemes 

 

If none of the built-in colour schemes work for 

your presentation you can create a custom 

palette. 

Choose a Theme from the Theme 

gallery under the Design tab, or move to the 

next step and start from scratch. 

Under the Design tab in the Themes 

group click on the Colours button. 

In the drop down menu select "Create New 

Theme Colours..." to bring up the Create 

New Theme Colours dialog box. 

Select colours for the elements of your slide by 

clicking the colour button beside the item you 

wish to change and choosing a new colour form 

the pull-down menu. You can also click More 

Colours for more custom colours. 

 

Note: The Sample on the left of the menu shows an image that is representative of different elements of 

your slide, so you can see how well the colours match. The image will change as you choose new colours. 

To start over with the colours you began with click Reset. 

To save your colour palette, type a name for your palette in the Name field and then click Save. 

Your palette will be added to the Colours pull-down gallery. 
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How to screenshot and image on your desktop and crop image 
 

A screenshot (also sometimes called a ‘screen grab’, ‘screen dump’ or ‘capture’) is a bit like taking a 

photograph of whatever is currently on your screen, which could be a website, a window or just the 

desktop. The image can then be pasted into a word-processed document.   

 

Step 1: Unless you’re taking a screenshot of just your desktop, make sure that the window you 

want to include in your screenshot is open. 

 

Step 2: Press the ‘Print screen’ key: Prt Sc or PrtScn. This is usually on the top row of the 

keyboard. When you press this, you’ll be taking a screenshot of the desktop. On some laptop 

keyboards, if the Prt Sc text is on the top line of a button, you will need to press and hold 

the Shift key and then press Prt Sc. 

 

Step 3: Immediately open a new Word document and click the ‘Paste’ icon, or hold down Ctrl on 

the keyboard and press V.  Your screenshot will now appear as an image in your document. 
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Step 4: You can also take a screenshot of just the active window. To do this, hold down Alt while 

you press Prt Sc or PrtScn. 

 

  

Step 5: You can resize your screenshot. Click on it and a frame will appear around the outside with 

small ‘handles’ on the corners and sides. You can change the size of the image by dragging on one or 

more of these handles with your mouse, making sure that the left mouse button is pressed down. 

 

  

Step 6: Your screenshot can be treated the same as any other inserted image. When you click on it, 

two new ‘picture tools’ tabs will appear in the ‘ribbon’. These give you a number of formatting 

options, such as cropping and special effects. 
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Step 7: Select Format on the toolbar and then select crop on the right hand side 
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APPENDIX 1:  Dataset Dictionary 
HIPE Portal Data Entry / Hip Fracture Admission (V5.0.1) 13 Dec 2016 

Question Options Explanation 

1. Date of trauma causing hip fracture  Date fracture happened 

1A. Time of trauma causing hip fracture  Time fracture happened (very seldom recorded see ED admission and 

orthopaedic admission) 

2. Type of trauma  1 High energy trauma 

2 Low energy trauma 

8 Unknown 

9 Not documented 

1= fall from above standing height ie. ladder, steps, RTA 

2= fall from standing height or less 

8= unknown mechanism of injury or no trauma 

9= not documented 

3. Date of arrival at first presenting hospital  Hospital that the patient first arrives at, this can be the peripheral 

hospital or the operating hospital 

3A. Time of arrival at first presenting hospital   Hospital that the patient first arrives at, this can be the peripheral 

hospital or the operating hospital 

4. Admission via ED in operating hospital 

 

1 Yes 

2 No 

1= they were admitted directly to the hospital that will operate on 

them 

2= no they came via another hospital 

4A. Date of arrival in ED of operating hospital   Date of arrival in the hospital that will operate on them 



 

 

 

     

NOCA - IHFD HB Version 4.0 June 2017   Page | 35 

Question Options Explanation 

4B. Time of arrival in ED of operating hospital   Time of arrival in the ED of the hospital that will operate, this time is 

recorded on the ED admission page 

4C. Date left ED in operating hospital  Date the patient left the ED to be admitted to a ward in the operating 

hospital 

4D. Time left ED in operating hospital   Time the patient left the ED to be admitted to a ward in the operating 

hospital (see ED notes or the time of arrival on the ward, usually 

recorded in the nursing notes) 

4E. Did patient go directly to theatre from ED 1 Yes 

2 No 

Was the patient fast-tracked and go directly to theatre without being 

admitted to an acute orthopaedic ward first? 

4F. Date seen by trauma team in operating 

hospital (if not admitted via ED) 

 Date that the orthopaedic team saw the patient either in the ED or on 

the ward directly if they were fast-tracked 

4G. Time seen by trauma team in operating 

hospital (if not admitted via ED) 

 Time that the orthopaedic team saw the patient either in the ED or on 

the ward directly if they were fast-tracked 

4H. Did patient fall during an existing inpatient 

admission in operating hospital 

1 Yes 

2 No 

Was patient already admitted as a patient and then fell and sustained a 

hip fracture while in the operating hospital? 

5. Type of ward admitted to in operating 

hospital 

1 Orthopaedic Ward 

2 Never Admitted to Orthopaedic Ward 

9 Not Documented 

1= if they were admitted to an orthopaedic ward at any point during 

their admission 

2= never admitted to an orthopaedic ward during this admission 

9= not documented, this field should rarely be selected as the ward 

admitted to should be available in the nursing notes. 



 

 

 

     

NOCA - IHFD HB Version 4.0 June 2017   Page | 36 

Question Options Explanation 

5A. Date of admission to orthopaedic ward  Date admitted to the orthopaedic ward 

5B. Time of admission to orthopaedic ward  Time admitted to the orthopaedic ward 

6A. Pre-fracture Indoor walking 0 Unable 

1 Assistance of one person 

2 With an aid 

3 Independent 

 

1: Unable to mobilise independently 

2: Mobiles with the assistance of one person 

3: Mobilises independently with an aid 

4: Mobilises independently 

6B. Pre-fracture Outdoor Walking 0 Unable 

1 Assistance of one person 

2 With an aid 

3 Independent 

 

1: Unable to mobilise independently 

2: Mobiles with the assistance of one person 

3: Mobilises independently with an aid 

4: Mobilises independently 

6C. Pre-fracture Shopping 0 Unable 

1 Assistance of one person 

2 With an aid 

3 Independent 

 

1: Unable to mobilise independently 

2: Mobiles with the assistance of one person 

3: Mobilises independently with an aid 

4: Mobilises independently 
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6D. Pre fracture New Mobility Score (NMS) 

(Sum A+B+C) 

 NMS Sum will total automatically calculate if there is a value entered 

for 6A, 6B & 6C 

7. AMT Performed 1 Yes 

2 No 

3 Patient Refused 

9 Not Documented 

AMT= Abbreviated Mental test Score 

1: Yes they had an AMT performed ( you will then be prompted to put 

in the score out of ten, this is usually done by a geriatrician or can be 

included in the ortho admission of the ICP) 

2: They did not have an AMT performed (we are not measuring any 

other assessment tool apart from AMT eg. MMSE not included) 

3: Patient refused to have AMT recorded. (this will most likely be 

recorded in the medical notes) 

9: not documented 

7A. AMTS 00 Zero 

01 One 

02 Two 

03 Three 

04 Four 

05 Five 

06 Six 

07 Seven 

08 Eight 

09 Nine 

10 Ten 

Self explanatory 

These results are for the AMT only no other cognitive assessment tool 

8. Side of fracture 1 Left 

2 Right 

3 Both 

1 & 2 self explanatory 

3: on a rare occasion a patient will present with bilateral hip fractures, 

in this instance you will be prompted to fill in the fracture details and 

types of fixation for both sides in one single episode. 
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8A. Type of fracture 1 Intracapsular - displaced 

2 Intracapsular - undisplaced 

3 Intertrochanteric 

4 Subtrochanteric 

5 Periprosthetic 

8 Other 

9 Not documented 

 

 

 

 

 

 

 

 

 

 

 

For all hip fractures the type of fracture must be written 

at the top of the operation note:  

The fracture may not be actually described in the admission notes, 

often #NOF is all that is documented but you can find more detail 

usually on the consent form.  3 =Intertrochanteric (Basal and basi-

cervical fractures are to be classed as intertrochanteric) 

8= Other this is if is something other then 1-4 but still in the proximal 

femur. 

See below for details of dropdown help box on portal for this question 

1 Intracapsular displaced may include Garden III or IV / Displaced 

Subcapital / Displaced Femoral Neck 

2 Intracapsular undisplaced may include Garden I or II / Impacted 

Intracapsular / Impacted Subcapital Fracture 

3 Intertrochanteric may include Pertrochanteric / Extracapsular / 

Basalcervical 

4 Subtrochanteric may include Reverse Oblique 

 

See diagram below re fracture type 
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8B. Type of fracture (Other, please specify)  This field is for a hip fracture on the contra lateral side only ie. if the 

patient has bilateral hip fractures on this admission 

8C. Type of fracture (Right) 1 Intracapsular - displaced 

2 Intracapsular - undisplaced 

3 Intertrochanteric 

4 Subtrochanteric 

5 Periprosthetic 

8 Other 

9 Not documented 

As above 8A 

8D. Type of fracture (Right, Other, please 

specify) 

  

9. Pathological 1 Atypical 

2 Malignancy 

3 No 

1= Atypical fractures are defined as resulting typically from prolonged 

bisphosphanate use. 

They present differently to normal hip fractures as they tend to be 
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9 Not documented transverse, non-comminuted and in the subtrochanteric region of the 

femur 

2= Malignancy refers to pathological fracture, often samples will be 

taken from the fracture site and this will be documented on the 

consent. 

3= No refers to low trauma fractures, so the majority of the hip 

fractures will fit into this category. This is the osteoporotic hip fracture 

group or low trauma fracture group. 

9= It is rare that you will be unable to determine which section it is. 

10. History of previous fragility fracture(s) 1 Yes 

2 No 

9 Not documented 

1= if they have a history of other low trauma fractures resulting from a 

fall from standing height or less, typical sites are the wrist, vertebrae, 

hip, humerus. 

2= no fractures or other fractures resulting from higher trauma fall 

into this group 

9= self explanatory 

11. Pre-op medical assessment 

 

 

1 Routine by Geriatrician 

2 Routine by Medical Physician 

6 None 

7 Geriatrician review following request 

8 Medical Physician review following request 

9 Not Documented 

1= Routine pre-operative review by a Geriatrician 

2 = Routine pre-operative review by a Medical Physician (Registrar 

level or above) 

6= none of the above (this does not include the orthopaedic team) 

7 = Geriatric assessment following request 

8 = Medical Physician assessment following request  

9 = Not documented 

** pre-operative= before surgery 

11A. Assessment by Geriatrician during Acute 

Admission 

1 Yes 

2 No 

9 Not documented 

Did patient have an assessment by Geriatrician during acute admission 

at any stage 
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11B. Geriatrician Assessment Date  If answer to Q11 is 1. Or 7. Or answer to Q11A is 1, then enter date 

of Geriatric assessment 

11C. Geriatrician Assessment Time  If answer to Q11 is 1. Or 7. Or answer to Q11A is 1, then enter time 

of Geriatric assessment 

11D. Geriatrician Grade 1 Consultant 

2 SpR 

3 Registrar 

8 Other 

9    Not Documented 

Grade of Geriatrician who assessed patient 

12. Operation 00 no oper. performed 

01 int fix DHS 

02 int fix Screws 

03 int fix IM nail long 

04 int fix IM nail short 

05 art uni-p hemi uncem uncoated 

06 art uni-p hemi uncem coated 

07 art uni-p hemi cem. 

08 art bi-p hemi uncem uncoated 

09 art bi-p hemi uncem coated 

10 art bi-p hemi cem. 

11 art THR uncem uncoated 

12 art THR uncem coated 

13 art THR cem. 

88 other 

99 not documented 

New Drop Down Help Boxes will assist with this question 

00= definite diagnosis of a fracture but not surgery completed either as 

a conservative option was chosen perhaps for an impacted old fracture 

or a stable greater or lesser trochanter fracture, or in some cases for 

palliative reasons. 

01= dynamic hip screw (DHS) 

02= cannulated screws 

03= in excess of 180mm, often 300mm 

04= usually less then 180mm 

05-10 should be amalgamated into two choices I think either cemented 

or uncemented hemi and maybe with a drop down for uni/bi-polar if its 

stated on the operation note  

11-13 should be amalgamated into THR cemented and uncemented 

88= all other types of fixation for the proximal femur eg. DCS plate  

99= the consent and theatre documentation should definitely have this 

recorded so this option should rarely be left blank. 
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12A. ASA Grade 1. Healthy person. 

2. Mild systemic disease. 

3. Severe systemic disease. 

4. Severe systemic disease that is a constant 

threat to life. 

5. A moribund person who is not expected 

to survive without the operation 

9.   9   Not documented 

This is self explanatory and normally determined by the anaesthetist 

and recorded on the anaesthetic record sheet or within the theatre 

documentation. 

12B. Type of Anaesthesia 1 GA only 

2 GA + nerve block 

3 GA + spinal anaesthesia 

4 GA + epidural anaesthesia 

5 SA only 

6 SA + nerve block 

7 SA + epidural (CSE) 

8 Other 

9 Not documented 

GA= General anaesthetic 

SA= Spinal anaesthetic 

 

This is usually documented on the anaesthetic record sheet and 

possibly within the theatre documentation 

 

12C. Surgeon Grade 

 

 

1 Consultant 

2 Specialist Registrar 

3 Registrar 

4 SHO 

8 Other 

9 Not documented 

All of the choices opposite refer to orthopaedic doctors of each grade 

specified. 

 

The person carrying out the surgery generally gets documented on the 

consent and within the theatre documentation. 

12C2. Was consultant orthopaedic surgeon 

present in the operating room 

1 Yes 

2 No 

9 Not documented 

 

 

 

http://en.wikipedia.org/wiki/Systemic_disease
http://en.wikipedia.org/wiki/Disease
http://en.wikipedia.org/wiki/Life
http://en.wiktionary.org/wiki/moribund
http://en.wikipedia.org/wiki/Surgery
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12D. Anaesthetist Grade 

 

 

1 Consultant 

2 Specialist Registrar 

3 Registrar 

4 SHO 

8 Other 

9 Not documented 

All of the choices opposite refer to anaesthetic doctors of each grade 

specified. 

This is usually documented on the anaesthetic record sheet and 

possibly within the theatre documentation 

12D2. Was consultant anaesthetist present in 

the operating room 

1 Yes 

2 No 

9 Not documented 

 

12E. Date of primary surgery  Date when the surgery to fix the hip fracture occurred  

12F. Time of primary surgery  The time of primary surgery is taken from the time of induction of 

anaesthesia. The time is shown in hours to 2 decimal place, e.g. 1.25 = 

1hr 15 mins,   3.5 = 3hrs 30 mins, 2.67=2hrs 40 mins. 

This time will be found in the theatre documentation. 

12G. Time from arrival in ED / seen by trauma 

team to surgery (hrs in decimal) 

 If you have completed the time fields for question 4B & 12E & F you 

just need to hit enter and this time will automatically be calculated. It 

is important to enter all times in four digits with no dots in 

between for example 1330 for have one and always use a 24 hour 

clock. 

12H. Reason if delay >48 hours 0 No delay - surgery < 48 hours 

1 Awaiting orthopaedic diagnosis or 

investigation 

2 Awaiting medical review investigation or 

stabilisation 

3 Awaiting inpatient or high dependency bed 

4 Awaiting space on theatre list 

5 Problem with theatre/equipment 

0= If surgery occurs within 48 hours  

1= If the surgery is delayed due to the need for further investigations 

for example a CT to determine if there is a fracture 

2= If the patient needs a medical review pre-operatively to stabilise or 

determine suitability to proceed with surgery 
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6 Problem with theatre/surgical/anaesthetic 

staff cover 

7 Cancelled due to list over-run 

8 Other 

9 Not documented 

 

 

3= If patients is awaiting a bed or HDU bed prior to surgery 

4= If the patient is awaiting space on the theatre list 

5= If problems with theatre or equipment are preventing surgery going 

ahead 

6= If staffing issues in theatre are preventing the surgery going ahead 

7= Cancelled due to other surgical cases preventing enough time on 

the trauma list  

8= Other (see 12H2) 

9= Not documented (It is often difficult to determine why a case is 

cancelled, the nursing notes is often a good place to look for the 

reason, or the orthopaedic notes.) 

12H2. Other Reason if delay >48 hours 8 Other This blank box can be populated with the reason for delay 

12J. Mobilised on day of, or day after surgery 1 Yes 

2 No 

9 Not documented 

 

12J2. Mobilised by 1 – Physiotherapist 

8 – Other 

9 - Not Documented 

If answer to 12J is YES then who mobilised patient on day of or day 

after surgery 

Physio 

Other: - If the patient is mobilised by nurses and other healthcare staff 

on day of or day after surgery 

Not Documented 

12K. Physiotherapy Assessment on day of or 

day after surgery 

1 Yes 

2 No 

9 Not documented 

Available in Physio notes 
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12L. Cumulated Ambulatory Score – day after 

surgery (0-6) 

0 - 6 Adding the three scores together gives the CAS score 

 

Bed mobility: 

0 Unable  

1 With assistance 

2 Independent 

 

Sit To Stand (STS): 

0 Unable  

1 With assistance 

2 Independent 

 

Mobility:  

0 Unable  

1 With assistance 

2 Independent 

12M. Re-operation within 30 days 0 None 

1 Reduction of dislocated prosthesis 

2 Washout or debridement 

3 Implant removal 

4 Revision of internal fixation 

5 Conversion to Hemiarthroplasty 

6 Conversion to THR 

7 Girdlestone/excision arthroplasty 

8 Surgery for periprosthetic fracture 

9 Not documented 

All of the choices here relate to within the first 30 days post hip 

fracture surgery 

13. Operation (Right) 00 no oper. performed 

01 int fix DHS 

02 int fix Screws 

03 int fix IM nail long 

04 int fix IM nail short 

05 art uni-p hemi uncem uncoated 

As above 
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06 art uni-p hemi uncem coated 

07 art uni-p hemi cem. 

08 art bi-p hemi uncem uncoated 

09 art bi-p hemi uncem coated 

10 art bi-p hemi cem. 

11 art THR uncem uncoated 

12 art THR uncem coated 

13 art THR cem. 

88 other 

99 not documented 

14. Pressure ulcers 1 Yes 

2 No 

9 Not documented 

1= This refers to a new pressure ulcer since admission grade 2 or 

above  

Grade 2 = Partial thickness loss of dermis presenting as a shallow open 

ulcer with a red pink wound bed, without slough. May also present as 

an intact or open / ruptured serum-filled or sero-sanginous filled 

blister. Presents as a shiny or dry shallow ulcer without slough or 

bruising*. This category should not be used to describe skin tears, tape 

burns, incontinence associated dermatitis, maceration or excoriation. 

*Bruising indicates deep tissue injury. 

NPUAP Guidelines  

NOTE if the patient develops a pressure after 120 days of admission 

for a hip fracture do not include this. 

 

15. Specialist Falls Assessment 0 No 

1 Yes - performed on this admission 

0= No falls assessment 

1= Yes if they are seen by a geriatrician as this will always be a part of 
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2 Yes - awaits further out-patient assessment their assessment 

Additionally if they have a specialist for falls assessment 

2= yes if they are referred to a specialist for falls assessment 

Please do not confuse this field will fall interventions, this is just to measure 

who is having a proper falls assessment 

16. Bone protection medication 0 No assessment  

1 Started on this admission 

2 Continued from pre-admission 

3 Awaits DXA scan 

4 Awaits out-patient assessment 

5 Assessed – no bone protection medication 

needed/appropriate 

0= No assessment done 

1= started on treatment during this admission see details below which 

constitute treatments: 

NOT just calcium and vit D 

 Bisphosphonates (oral, combined with Ca/ Vit D, iv) e.g. 

Alendronate, Risedroante, Edidronate, Ibandronate, 

Pamidronate, Zolendronate  (Fosamax, Fosavance, Actonel, 

Bonviva, Aredia, Aclasta) 

 HRT eg Tibolone 

 SERMS eg  Raloxifene 

 Parathyroid hormone eg Forsteo, PTH 1-34, PTH 1-84 

 Strotium ranelate (Protelos) 

 Denosumab (Prolia) 

 Calcium and vitamin D , Calcitrol  

 

2= If they came in on one of the above treatments already and this was 

continued on discharge 

3= Awaiting a DXA scan 

4= Awaiting an out-patient appointment in a clinic ie. fracture liaison, 
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falls & bone health clinic or geriatric clinic 

5= If the patient was assessed for bone health and the decision was 

made to not treat them for a variety of reasons such as malignancy, 

unwell, severe renal impairment or that it simply is not required. 

17. Multidisciplinary rehabilitation team 

assessment 

1 Yes 

2 No 

9 Not documented 

1= Yes means they were seen by a variety of professionals such as a 

nurse, doctor, physiotherapist, occupational etc during their admission.  

18. Cumulated Ambulatory Score – day of 

acute hospital discharge (0-6) 

 See scoring as for 12L above 

19. Where was the patient discharged to 

following the acute hospital spell? 

1 Home 

2 On-site rehab unit 

2 Off-site rehab unit 

3 Convalesence care 

5    New admission to nursing home or                

long-stay care 

6 Return admission to nursing home or 

long stay care 

8 Other  

Which option represents the reason for discharge to location if other 

than home 

Return admission to a nursing home/long stay care should only be 

selected if source of admission for this acute episode was from a 

nursing home/long stay care. 

19A Discharged to (Other, please specify)  If option 8 answered for Q19 then complete 19A 

20. Is admission data entry complete for this 

episode? 

1 Yes 

2 No 

1= Yes if you have extracted as much of the information as possible 

and the patient has been discharged then select yes. If a patient is still 

an inpatient then you cannot definitively say that they may not develop 

pressure ulcers or have all their assessments completed so only 

complete the data entry when you are sure the episode of care is 

completed. 

2= self explanatory 
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APPENDIX 2:  

IHFD Frequently asked questions 

 

Question Answer 

What does IHFD stand for? Irish Hip Fracture Database 

 

Who are the members of the 

IHFD Governance Committee? 

Mr Conor Hurson, IHFD Clinical lead, Orthopaedic Surgeon  

Dr Emer Ahern, IHFD Clinical lead, Geriatrician 

Louise Brent, IHFD Audit Coordinator, Orthopaedic Nurse 

Philip Dunne, IT  Systems Support, Healthcare Pricing Office, Health Services Executive (HSE) 

Catherine Farrell, Programme Manager Trauma and Orthopaedic Programme 

Michelle Fitzgerald, Physiotherapy Representative 

Dr Tara Coughlan, Irish Gerontological Society 

Mr Paddy Kenny, Irish Institute of Trauma and Orthopaedic Surgeons (IITOS) Representative 

Dr Michael Looney, Anaesthesia Representative 

Dr Geraldine McMahon, Emergency Medicine Representative 
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Question Answer 

How do I get access to the IHFD? The lead clinician for the IHFD in your hospital should email (from his/her HSE/ Hospital email address)  

Philip.Dunne@hpo.ie  requesting access to the database. The email should include the names, designations and 

contact details of any personnel within the hospital requiring IHFD access. All subsequent requests for access must 

also come from the lead clinician. 

What do I do if I forget my 

username and password? 

Contact Philip.Dunne@hpo.ie 

 

Can I view anyone else's data?     No, each hospital is registered separately 

Can more than one person in a 

hospital be given access to the 

database for data entry? 

The clinical lead and data coordinator have access, it will be at the discretion of the clinical lead to grant further 

access. However if access is being requested to gain information that can be exported into a file then access should 

not be granted and  the clinical lead should instruct the data coordinator to share that information. Access to the 

portal should be kept to a minimum in each site. 

 

mailto:Philip.Dunne@hpo.ie
mailto:Philip.Dunne@hpo.ie
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Question Answer 

How long will it take to enter 

data?  

 

 

 

 

 

 

There are two options for Data Entry. 

This will vary according to experience but no more than approximately 1-2 minutes per patient entry. 

1. Pre-Discharge 

a. Type in the Medical Record Number e.g. 1234567 

b. Click on New Case  

c. Enter the hip fracture data 

d. Click on Store 

Note: Only select the option “Store as Non-Admitted Episode” if you are sure the patient 

was not admitted during this episode of care. 

If you choose to enter pre-discharge data, the system will automatically merge the hip fracture data and the 

HIPE data after the patient has been discharged 

2. Post-Discharge 

a. Type in the Medical Record Number e.g. 1234567 

b. Click on the relevant Discharge Date 

c. Enter the hip fracture data (under “Optional” tab) 

d. Click on Store 
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Question Answer 

Once submitted, can I retrieve 

records to edit content? 

Yes, at any time 

What if date of Trauma is not 

documented? 

Date of trauma; if unknown enter 99-99-99 

What if the patient is transferred 

from another hospital? 

 First presenting hospital 

Document the hospital the patient first presents at e.g. The patient presents at a hospital with no orthopaedic 

service and has to be transferred to an operating hospital.  The time starts ticking from presentation at the first ED 

or if a transfer from within a hospital with no orthopaedic service to an operating hospital enter 'date and time seen 

by trauma team' as most likely time when diagnosis is made. 

In most cases the first presenting hospital will be the same as the operating hospital.  This should still be 

documented 

If the patient is fast tracked to 

surgery before being admitted to 

orthopaedic ward – how do I 

record this. 

Blue Book Standard 1 - All patients with hip fracture should be admitted to an acute orthopaedic ward within 4 

hours of presentation.   We recognise that in the Irish system not all patients are admitted to an orthopaedic ward 

before being sent to theatre.  This is covered in question 4E - Did patient go directly to theatre from ED? 

If the patient is admitted from 

within hospital - how do I record 

this? 

We recognise that some patients may sustain a hip fracture whilst already in hospital or may require acute medical 

management (i.e. are not admitted primarily as a fractured hip). This is now covered by question 4H -Did patient fall 

during an existing inpatient admission in operating hospital? 
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Question Answer 

Admission to orthopaedic ward 

 

 

Includes dedicated geriatrician-staffed hip fracture wards as well as conventional orthopaedic/trauma wards.  

Enter Orthopaedic ward if in-patient on an orthopaedic ward at any time during the acute hip fracture spell. 

 

AMTS (Abbreviated Mental Test 

Score) 

This 10 item version is a simple and robust screening tool in the acute patient. Full assessment for confused people 

(AMTS less than 7) requires more detailed tools for cognition (MMSE) or presence of delirium (CAM). 

Fracture type There are two help boxes to assist with Type of Fracture 

For all hip fractures the type of fracture must be written at the top of the operation note:  

1  Intracapsular - displaced 

2  Intracapsular - undisplaced 

3  Intertrochanteric (Basal and basi-cervical fractures are to be classed as intertrochanteric) 

4  Subtrochanteric 

5  Periprosthetic 

8  Other 

Other should only be used if fracture does not fit the other options eg trochanteric 

 

Arthroplasty Any replacement of the upper femur including unipolar, bipolar hemi-arthroplasties and total hip replacements 
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Question Answer 

What is a pathological fracture? A bone broken, caused not by trauma alone, but so weakened by disease as to break with abnormal ease. 

Pathological fractures are characteristic of primary and metastatic malignant disease and myeloma. Answer 

Malignancy only if primary or secondary malignancy present at the fracture site. 

What is an atypical fracture? Atypical fractures are transverse femoral fractures, with an unusual cortical spike medially, that occur in the 

subtrochanteric and shaft regions (you should only enter subtrochanteric fractures to the database). They follow 

low trauma injuries and patients may report pre-injury pain.  

Normal working hours? The National Confidential Enquiry into Peri-operative Deaths (NCEPOD) reports of 1997 and 2003 define “out of 

hours” as any time outside 08:00 to 17:59 Sunday to Saturday. 

When is considered time of 

primary surgery? 

The time of primary surgery is taken from the time of induction of anaesthesia. The time is shown in hours to 2 

decimal place, e.g. 1.25 = 1hr 15 mins,   3.5 = 3hrs 30 mins, 2.67=2hrs 40 mins. 

When does the clock start 

ticking? 

 

 

 

 

 

As soon as the patient arrives in ED or is seen by the trauma team. 

Scenario 1: Hip pain, initial X-ray, no fracture seen, then CT/ MRI identifies fracture, time of arrival to ED to be 

used 

Scenario 2 :SHO misses fracture, radiologist report shows fracture, time of first arrival to ED to be used  

Scenario 3: Impacted or old fracture, treated conservatively, trial of mobilisation fails, time of arrival to ED to be 

used 

Scenario 4: ED diagnosis ? fracture, awaiting CT/ MRI, time of first arrival to ED to be used. 

Scenario 5: Patient falls as an inpatient, time seen by trauma team to be used 

http://www.medterms.com/script/main/art.asp?articlekey=4484
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Question Answer 

What is an ASA Score? The American Society of Anaesthesiologists (ASA) devised a preoperative risk score based on the presence of co-

morbidities at the time of surgery  

American Society of Anesthesiologists8 (ASA 1963) physical status classification: 

1. A normal healthy patient 

2. A patient with a mild systemic disease 

3. A patient with a severe systemic disease that limits activity, but is not incapacitating 

4. A patient with an incapacitating systemic disease that is a constant threat to life 

5. A moribund patient not expected to survive 24 hours with or without operation 

This grading does not take into account acute illness, hence a patient can be ASA 1 and ‘unfit’. 

What is meant by ’Routine by 

Medical Physician’? 

Review by a medical physician at Registrar level or above ie not an Orthopaedic Surgeon. 

What is meant by ’Routine by 

Geriatrician’? 

Review by a geriatrician at Registrar level or above. 

What is meant by ’Medical 

Physician review following 

request’? 

Review by a member of the medical team at Registrar level or above following a request from the orthopaedic 

service. 
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Question Answer 

What is meant by 'Specialist 

nurse'? 

Review by specialist nurse CNM 2 level or above. 

Issues surrounding delay to 

surgery 

Please document only the main reason for delay. Options are: 

 Medically unfit - awaiting orthopaedic diagnosis/investigation - this means waiting for MRI scan or other 

confirmation of diagnosis. 

 Medically unfit - awaiting medical review/investigation or stability - this means waiting for a medical review 

as patient remains medically unfit for surgery/anaesthetic  

 Administrative/logistic - awaiting in-patient or high dependency bed  

 Administrative/logistic - awaiting space on theatre list  

 Administrative/logistic - problem with theatre /equipment 

 Administrative/logistic - problem with theatre/surgical/anaesthetic staff cover  

 Cancelled due to theatre over-run - this option is to be used when the patient has been allocated a theatre 

slot - but for some reason the list has over-run. 

 Other - any other reason than the list above If you select “other” an empty box will appear so you can 

populate it with the reason for delay 

 No operation performed 

Pressure ulcers 

 

Did patient acquire a new pressure ulcer (Grade 2 or above) during the acute admission? 

 This should be answered as 'yes' only if the patient has developed a grade 2 pressure ulcer or above 
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Question Answer 

during their acute orthopaedic admission.  

 Ignore ulcers acquired during an acute stay but more than 120 days after admission.  

 If nothing is documented and the patient has left the hospital 'not documented' must be recorded. 

Definition of a Ward Round The ward round is a parade through the hospital, of professionals where most decision making concerning patient 

care is made. The round provides an opportunity for the multidisciplinary team to listen to the patient's narrative 

and jointly interpret his concerns. From this unfolds diagnosis, management plans, prognosis formation and the 

opportunity to explore social, psychological, rehabilitation and placement issues.  

Physical examination of the patient at the bedside still remains important.  

Anatomy of the ward round, James A. O'Hare European Journal of Internal Medicine - July 2008 (Vol. 19, Issue 5, 

Pages 309-313, DOI: 10.1016/j.ejim.2007.09.016) 

Specialist falls assessment 

 

A systematic assessment by a suitably trained person e.g. Geriatrician or a specialist assessment trained nurse which 

must cover the following domains:  

Falls history (noting previous falls),  

cause of index fall (including medication review),  

risk factors for falling and injury (including fracture)  

and from this information formulate and document a plan of action to prevent further falls. 
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Question Answer 

Definition of Multidisciplinary 

Rehabilitation Assessment Team 

A group of people of different professions (and including as a minimum a physiotherapist, occupational therapist, 

nurse and doctor) with job plan responsibilities for the assessment and treatment of hip fracture patients, and who 

convene (including face to face or virtual ward round) regularly (and at least weekly) to discuss patient treatment 

and care and plan shared clinical care goals.  
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Question Answer 

What drugs constitute bone                    

protection therapy? 

NOT just calcium and vitamin D 

1. Bisphosphonates (oral, combined with Calcium/ 

Vitamin D, intravenously)  

 Etidronate 

 Alendronate 

 Risedronate 

 Ibandronate 

 Zoledronate 

 Pamidronate 

 

2. Denosumab 

 

3. HRT and SERMS  

 HRT (various) 

 Tibolone 

 Raloxifene 

 

 

 

 

 

 

 

4. Parathyroid hormone 

 PTH 1-34 

 PTH 1-84 

 

5. Strontium 

Strontium ranelate 

 

6. Calcium and vitamin D 

Calcitriol  

Calcium and vitamin D – various 

Alpha-calcidol (or one alpha) 

7. Calcitonin 
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Question Answer 

Minimum age? We collect the data on all patients over the age of 30 but to date only report on those 60 and above. 

Pre fracture New Mobility Score This is a new field for 2016 and there has been communication directly to Physiotherapy departments regarding the 

collection of the scores 

If you do not have a score recorded for any of Q6A, Q6B & Q6C then leave them blank 

How do I calculate Question 6D 

if not all fields are answered? 

Q6D will auto calculate  

Cumulated Ambulatory Score 

(CAS) Score 0 - 6 

Bed mobility:  

0 Unable  

1 With assistance 

2 Independent 

Sit To Stand (STS): 

0 Unable  

1 With assistance 

2 Independent 

Mobility:  

0 Unable  

1 With assistance 

2 Independent 
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Question Answer 

CAS day after surgery - Does 

score need to be recorded daily? 

No, just on day after surgery and again on day of acute discharge 

CAS – day of acute hospital 

discharge -What if happens if 

patient is discharged at the 

weekend and there are no 

physio’s on duty? 

Retrospectively fill it in on Monday based on the nursing note on day of discharge, or the last physio note if it was 

recent. 

What is required for Q18 - 

Where was the patient 

discharged to following the acute 

hospital spell?   

Fill in the option which represents the reason / intent for patient’s initial care after being discharged to a location 

other than home. 
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APPENDIX 3: Data Collection Proforma Sheets 
 

 

 

 

 

 

 

 



 
 
       
 

 

IRISH HIP FRACTURE DATABASE DATA COLLECTION SHEET V5.0.1 

Question Options 
Answer (Complete 
date/ time in 24h clock 
or circle relevant 
answer 

1. Date of trauma causing hip fracture  Date: 

1A. Time of trauma causing hip fracture  Time: 

2. Type of trauma  1 High energy trauma,  2 Low energy trauma 
8 Unknown, 9 Not documented 

1      2      8      9 

3. Date of arrival at first presenting hospital  Date:  

3A. Time of arrival at first presenting 
hospital  

 Time: 

4. Admission via ED in operating hospital 1 Yes, 2 No 1      2 

4A. Date of arrival in ED of operating 
hospital  

 Date: 

4B. Time of arrival in ED of operating 
hospital  

 Time: 

4C. Date left ED in operating hospital  Date:  

4D. Time left ED in operating hospital   Time 

4E. Did patient go directly to theatre from 
ED 

1 Yes, 2 No 1      2 

4F. Date seen by orthopaedic team in 
operating hospital (if not admitted via ED) 

 Date: 

4G. Time seen by orthopaedic team in 
operating hospital (if not admitted via ED) 

 Time: 

4H. Did patient fall during an existing 
inpatient admission in operating hospital 

1 Yes, 2 No 1      2 

5. Type of ward admitted to in operating 
hospital 

1 Orthopaedic Ward 
2 Never Admitted to Orthopaedic Ward 
9 Not Documented 

1      2      9 

5A. Date of admission to orthopaedic ward  Date:  

5B. Time of admission to orthopaedic ward  Time: 

6A. Pre-fracture Indoor Walking 0 Unable   1 Assistance of one person 
2 With an aid   3 independent 

0      1      2      3 

6B. Pre-fracture Outdoor Walking 0 Unable   1 Assistance of one person 
2 With an aid   3 independent 

0      1      2      3 

6C. Pre-fracture Shopping 0 Unable   1 Assistance of one person 
2 With an aid   3 independent 

0      1      2      3 

6D. Pre-fracture New Mobility Score (Sum 
A+B+C) 

  /9 

7. AMT Performed 1 Yes, 2 No  3 Patient Refused, 9 Not Documented 1      2      3      9 

7A. AMTS 00 - 10 /10 

8. Side of fracture 1 Left, 2 Right, 3 Both 
 

1      2      3 

8A. Type of fracture 1 Intracapsular – displaced 2 Intracapsular - undisplaced 
3 Intertrochanteric   4 Subtrochanteric 

1      2      3      4      5      
8      9 



 
 
       

5 Periprosthetic  8 Other  9 Not documented 

8B. Type of fracture (Other, please specify)  If answer is 8 specify: 

8C. Type of fracture (Right) See Q8A  

8D. Type of fracture (Right, Other, please 
specify) 

  

9. Pathological 1 Atypical, 2 Malignancy  3 No, 9 Not documented  

10. History of previous fragility fracture(s) 1 Yes, 2 No, 9 Not documented 1      2      9 

11. Pre-op medical assessment 1 Routine by geriatrician  2 Routine by medical physician 
6 None 7 Ger review following request 
8 Med physician review following request 
9 Not documented 

1      2      6      7      8      
9 

11A. Assessed by Geriatrician during this 
acute admission 

1 Yes, 2 No, 9 Not documented 1      2      9 

11B. Geriatrician Assessment Date   Date: 

11C. Geriatrician Assessment Time   Time: 

11D. Geriatrician Grade 1 Consultant  2 SpR  3 Registrar  8 Other 
9 Not documented 

1      2      3      8      9 

12. Operation 00 no oper. Performed  01 int fix DHS 
02 int fix Screws   03 int fix IM nail long 
04 int fix IM nail short  05 art uni-p hemi uncem uncoated 
06 art uni-p hemi uncem coated  07 art uni-p hemi cem. 
08 art bi-p hemi uncem uncoated 09 art bi-p hemi uncem 
coated  10 art bi-p hemi cem  11 art THR uncem 
uncoated  12 art THR uncem coated  13 art THR cem. 
88 other  99 not documented 

 
00   01   02   03   04   05    

 
06   07   08   09   10  

 
  11   12   13   88 

12A1. Type of implant (fx type = 
intracapsular) 

1 ETS  2 Bipolar Exeter  3 Corail  4 Austin Moore 
5 C Stem  6 Thompsons  7 Charley Bipolar 
8 Trilliance  9 Pinnacle  

1   2   3   4   5   6   7   8   
9 

12A2. Type of implant (fx type = 
intertrocanter) 

1 Screws  2 DHS  3 Gamma nail long 
4 Gamma nail short  5 Intertan  

1   2   3   4   5 

12A3. Type of implant (fx type = 
periprosthetic) 

1 ORIF 2 Revision  1     2 

12A. ASA Grade 1 Normal healthy individual 
2 Mild systemic disease that does not limit activity 
3 Severe systemic disease that limits activity but is not 
incapacitating 
4 Incapacitating systemic disease which is constantly 
life-threatening 
5 Moribund - not expected to survive 24 hours with or 
without surgery 
9 Not documented 

1   2   3   4   5   9 

12B. Type of Anaesthesia 1 GA only  2 GA + nerve block 
3 GA + spinal anaesthesia  4 GA + epidural anaesthesia 
5 SA only  6 SA + nerve block 
7 SA + epidural (CSE)  8 Other  9 Not documented 

1   2   3   4   5   6   7   8   
9 

12C. Surgeon Grade 1 Consultant    2 Specialist Registrar   3 Registrar 
4 SHO   8 Other   9 Not documented 

1   2   3   4   8   9 

12C2. Was consultant orthopaedic surgeon 
present in the operating room 

1 Yes   2 No   9 Not documented 1   2   9 

12D. Anaesthetist Grade 1 Consultant   2 Specialist Registrar   3 Registrar 
4 SHO   8 Other   9 Not documented 

1   2   3   4   8   9 

12D2. Was consultant anaesthetist present 
in the operating room 

1 Yes  2 No  9 Not documented 1   2   9 

12E. Date of primary surgery  Date: 



 
 
       

12F. Time of primary surgery  Time: 

12H. Reason if delay >48 hours 0 No delay - surgery < 48 hours 
1 Awaiting orthopaedic diagnosis or investigation 
2 Awaiting medical review investigation or stabilisation 
3 Awaiting inpatient or high dependency bed 
4 Awaiting space on theatre list 
5 Problem with theatre/equipment 
6 Problem with theatre/surgical/anaesthetic staff cover 
7 Cancelled due to list over-run 
8 Other 
9 Not documented 

0   1   2   3   4   5   6   7   
8   9 

12H2. Other Reason if delay >48 hours   If answer is 8 specify: 

12J. Mobilised on day of, or day after 
surgery 

1 Yes 2 No, 9 Not documented 1      2      9 

12J2. Mobilised by 1 Physiotherapist  8 Other, 9 Not documented 1      8      9 

12K. Physiotherapy Assessment on day of, 
or day after surgery 

1 Yes  2 No, 9 Not documented 1      2      9 

12L. Cumulated Ambulatory Score – day 
after surgery (0 - 6) 

  /6 

12M. Re-operation within 30 days 0 None  1 Reduction of dislocated prosthesis 
2 Washout or debridement  3 Implant removal 
4 Revision of internal fixation 
5 Conversion to Hemiarthroplasty   6 Conversion to THR 
7 Girdlestone/excision arthroplasty 
8 Surgery for periprosthetic fracture  9 Not documented 

0   1   2   3   4   5   6   7   
8   9 

13. Operation (Right) See Q12  

14. Pressure ulcers 1 Yes, 2 No, 9 Not documented 1      2      9 

15. Specialist Falls Assessment 0 No, 1 Yes - performed on this admission 
2 Yes - awaits further out-patient assessment 

0      1      2      

16. Bone protection medication 0 No assessment   1 Started on this admission 
2 Continued from pre-admission  3 Awaits DXA scan 
4 Awaits out-patient assessment 
5 Assessed – no bone protection medication 
needed/appropriate 

0      1      2      3      4      
5 

17. Multidisciplinary rehabilitation team 
assessment 

1 Yes, 2 No, 9 Not documented 1      2      9 

18. Cumulated Ambulatory Score – day of 
acute hospital discharge (0 - 6) 

  /6 

19. Where was the patient discharged to 
following the acute hospital spell? 

1 Home   2 On-site rehab unit   3 Off-site rehab unit 
4 Convalescence care 
5 New adm to nursing home or long-stay care 
6 Return adm to nursing home or long-stay care 
8 Other  

1   2   3   4   5   6   8 

19A. Discharged to (Other, please specify)   Is answer is 8 specify: 

20. Is admission data entry complete for this 
episode? 

1 Yes, 2 No 1      2 
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